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Preface

Manual Information

Purpose
This manual details the features, installation procedures, operational 
procedures, and specifications of the following distribution amplifiers:
• DA-H6802+ 1×8 3G/HD-SDI/SD-SDI distribution amplifiers
• DA-HR6802+ 1×8 3G/HD-SDI/SD-SDI distribution amplifiers with 

reclocking
• DA-S6802+ 1×8 SD-SDI distribution amplifiers
• DA-SR6802+ 1×8 SD-SDI distribution amplifiers with reclocking

Audience
This manual is written for engineers, technicians and operators responsible for 
the installation, setup, and / or operation of the DA-H6802+, DA-HR6802+, 
DA-S6802+, and DA-SR6802+ distribution amplifiers.

Revision History
Table P-1. Manual Revision History

Edition Date Revision History
A December 2008 Initial release
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Writing Conventions
To enhance your understanding, the authors of this manual have adhered to the 
following text conventions:

Obtaining Documents
Product support documents can be viewed or downloaded from our website. 
Alternatively, contact your Customer Service representative to request a 
document.

Table P-2. Manual Style and Writing Conventions

Term or 
Convention Description

Bold Indicates dialog boxes, property sheets, fields, buttons, 
check boxes, list boxes, combo boxes, menus, submenus, 
windows, lists, and selection names.

Italics Indicates email addresses, the names of books or 
publications, and the first instances of new terms and 
specialized words that need emphasis.

CAPS Indicates a specific key on the keyboard, such as ENTER, 
TAB, CTRL, ALT, or DELETE.

Code Indicates variables or command-line entries, such as a 
DOS entry or something you type into a field.

> Indicates the direction of navigation through a hierarchy 
of menus and windows.

hyperlink Indicates a jump to another location within the electronic 
document or elsewhere

Internet address Indicates a jump to a website or URL

Note
Indicates important information that helps to avoid and 
troubleshoot problems.
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Unpacking/Shipping Information

Unpacking a Product
This product was carefully inspected, tested, and calibrated before shipment to 
ensure years of stable and trouble free service. 
1. Check equipment for any visible damage that may have occurred during 

transit. 
2. Confirm that you have received all items listed on the packing list. 
3. Contact your dealer if any item on the packing list is missing.
4. Contact the carrier if any item is damaged.
5. Remove all packaging material from the product and its associated 

components before you install the unit.

Product Servicing
 
These modules are not designed for field servicing. All hardware and firmware 
upgrades, modifications, or repairs require you to return the modules to the 
Customer Service center.

Returning a Product
In the unlikely event that your product fails to operate properly, please contact 
Customer Service to obtain a Return Authorization (RA) number, then send the 
unit back for servicing.
Keep at least one set of original packaging, in the event that you need to return a 
product for servicing. If the original packaging is not available, you can 
purchase replacement packaging at a modest cost or supply your own packaging 
as long as it meets the following criteria:
• Withstands the weight of the product
• Holds the product rigid within the packaging
• Leaves at least two inches of space between the product and the container
• Protects the corners of the product
Ship products back to us for servicing prepaid and, if possible, in the original 
packaging material. If the product is still within the warranty period, we will 
return the product prepaid after servicing.
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Safety Standards and Compliances
See the 6800+ Safety Instructions and Standards Manual to find the safety 
standards and compliances for this 6800+ series product. A safety manual is 
shipped with every FR6802+ Frame Installation and Operation Manual and 
can be downloaded from our website. Alternatively, contact your Customer 
Service representative for a copy of this safety manual.

Safety Terms and Symbols
This product manual uses the following safety terms and symbols to identify 
certain conditions or practices. See the 6800+ Safety Instructions and Standards 
Manual for more information. 

Table P-3. Safety Terms and Symbols

Symbol Description
WARNING: Identifies conditions or practices that can result in 
personal injury or loss of life—high voltage is present. 
Uninsulated dangerous voltage within the product’s enclosure 
may be sufficient to constitute a risk of electric shock to 
persons.

CAUTION: Identifies conditions or practices that can result in 
damage to the equipment or other property. Important operating 
and maintenance (servicing) instructions are included in the 
literature accompanying the product.
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Restriction on Hazardous Substances (RoHS) Directive
Directive 2002 / 95 / EC—commonly known as the European Union (EU) 
Restriction on Hazardous Substances (RoHS)—sets limits on the use of certain 
substances found in electrical and electronic equipment. The intent of this 
legislation is to reduce the amount of hazardous chemicals that may leach out of 
landfill sites or otherwise contaminate the environment during end-of-life 
recycling. The Directive, which took effect on July 1, 2006, refers to the 
following hazardous substances: 
• Lead (Pb)
• Mercury (Hg)
• Cadmium (Cd)
• Hexavalent Chromium (Cr-V1)
• Polybrominated Biphenyls (PBB)
• Polybrominated Diphenyl Ethers (PBDE)
In accordance with this EU Directive, products sold in the European Union will 
be fully RoHS-compliant and “lead-free.” (See our website for more 
information.) Spare parts supplied for the repair and upgrade of equipment sold 
before July 1, 2006 are exempt from the legislation. Equipment that complies 
with the EU directive will be marked with a RoHS-compliant symbol, as shown 
in Figure P-1.

Figure P-1. RoHS Compliance Symbol
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Waste from Electrical and Electronic Equipment  
(WEEE) Directive

The European Union (EU) Directive 2002 / 96 / EC on Waste from Electrical and 
Electronic Equipment (WEEE) deals with the collection, treatment, recovery, 
and recycling of electrical and electronic waste products. The objective of the 
WEEE Directive is to assign the responsibility for the disposal of associated 
hazardous waste to either the producers or users of these products. As of August 
13, 2005, producers or users are required to recycle electrical and electronic 
equipment at end of its useful life, and must not dispose of the equipment in 
landfills or by using other unapproved methods. (Some EU member states may 
have different deadlines.)
In accordance with this EU Directive, companies selling electric or electronic 
devices in the EU will affix labels indicating that such products must be 
properly recycled. (See our website for more information.) Contact your local 
Sales representative for information on returning these products for recycling. 
Equipment that complies with the EU directive will be marked with a 
WEEE-compliant symbol, as shown in Figure P-2.

Figure P-2. WEEE Compliance Symbol
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Chapter 1

Introduction

Overview
The following topics are described in this chapter:
• “Main Features” on page 2
• “Module Descriptions” on page 4
• “Product Description” on page 2
• “Signal Flow” on page 6
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Product Description
The DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ series of 
distribution amplifiers are designed to distribute serial digital video signals 
according to SMPTE 257C, DVB, and other related standards. They feature 
high reliability, excellent video performance, and low cost.
The individual modules are available as follows:
• DA-H6802+: 1×8 3G/HD-SDI/SD-SDI distribution amplifiers
• DA-HR6802+: 1×8 3G/HD-SDI/SD-SDI distribution amplifiers with 

reclocking 
• DA-S6802+: 1×8 SD-SDI distribution amplifiers
• DA-SR6802+: 1×8 SD-SDI distribution amplifiers with reclocking 
You can can control and monitor these distribution amplifier modules locally 
(via card-edge LEDs) or remotely (via RS-232 ports or optional ICE6800+ and 
6800+ETH Ethernet connection).

Main Features
DA-H6802+
• One input, eight outputs
• Input signal presence detect and report
• Automatic input cable equalization
• Maximum equalized cable length adjustable (for 270 Mb/s and remotely 

only)
• Direct fanout the input signal (5 Mb/s to 3 Gb/s) without reclocking
• Card-edge control by jumpers with LED display
• Remote control via RS-232 or Ethernet

DA-HR6802+
• One input, eight outputs
• Input signal presence detect and report
• Automatic input cable equalization
• Maximum equalized cable length adjustable (for 270 Mb/s and remotely 

only)
• Reclocking Mode selectable as automatic or manual
• Re-lockable for 270 Mb/s, 1.5 Gb/s and 3.0 Gb/s SMPTE signal
• Re-lockable for DVB-ASI signal
• Reclock status and rate report by LEDs
• Reclocking Bypass mode is selectable as automatic or enforced
• Card-edge control by jumpers with LED display
• Remote control via RS-232 or Ethernet
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DA-S6802+
• Input signal presence detect and report
• Automatic input cable equalization
• Eight fanout outputs
• LED display on card edge
• Remote monitoring via RS-232 or Ethernet

DA-SR6802+
• One input, eight outputs
• Input signal presence detect and report
• Automatic input cable equalization
• Automatic reclocking 270 Mb/s SMTPE SD and DVB-ASI
• Reclock status and rate report by LEDs
• Automatic bypass reclocking stage if not relockable
• Card edge control by jumpers with LED display
• Remote monitoring via RS-232 or Ethernet

Typical Broadcast and Production Applications
DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ distribution 
amplifiers can be used in broadcast, cable, production, educational, and 
auditorium applications where high performance SD-SDI signal distribution is 
required. 
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Module Descriptions

Front Module
Figure 1-1 is a generic top-front view of a typical front module. See Figure 3-2 
on page 20 and Figure 3-3 on page 21 for LED locations.

Figure 1-1. Typical Front Module

Back Modules
DA-H/HR6802+ and DA-S/SR6802+ modules can be installed with 
double-width (1×8) or single-width (1×4) back modules in FR6802+QX(F) and 
FR6802+DM frames. These modules cannot be installed in 6800 / 7000 series 
frames.

FR6802+ Frame Back Modules
Figure 1-2 on page 5 shows the double-width back connector module used by 
the DA-H/HR6802+and DA-S/SR6802+ when installed in an FR6802+XF, 
FR6802+QXF, or FR6802+DM frame.
Figure 1-3 on page 5 shows the single-width back connector module used by the 
DA-H/HR6802+and DA-S/SR6802+ when installed in an FR6802+XF, 
FR6802+QXF, or FR6802+DM frame.
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Figure 1-2. Double-Width Back Module for FR6802+X(F) and 
FR6802+DM Frames

Figure 1-3. Single-Width Back Module for FR6802+X(F) and 
FR6802+DM Frames
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Signal Flow

Figure 1-4. Signal Flow Diagram
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Chapter 2

Installation

Overview
This chapter describes DA-H6802+, DA-HR6802+, DA-S6802+, and 
DA-SR6802+ modules’ installation process, including the following topics:
• “Installing Modules” on page 12
• “Making Connections” on page 12
• “Maximum 6800+ Frame Power Ratings” on page 8
• “Removing Modules” on page 12
• “Required Frames and Back Module Connector Types” on page 12
• “Setting Jumpers” on page 11
• “Unpacking the Module” on page 8
See the FR6802+ Frame Installation and Operation Manual for information 
about installing and operating an FR6802+ frame and its components.

Caution
Before installing this product, read the 6800+ Series Safety Instructions 
and Standards manual shipped with every FR6802+ Frame Installation 
and Operation Manual, or downloadable from our website. This safety 
manual contains important information about the safe installation and 
operation of 6800+ series products.
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Maximum 6800+ Frame Power Ratings
Power consumption information is listed in Chapter 4: “Specifications” on 
page 26.
Table 2-1 describes the maximum allowable power ratings for 6800+ frames. 
Note the given maximums before installing any 6800+ modules in your frame.
DA-H/HR6802+ and DA-S/SR6802+ modules can be installed in FR6802+ 
frames. They cannot be installed in 6800 / 7000 series frames.

Unpacking the Module

Preparing for Installation
Before you install DA-H/HR6802+ or DA-S/SR6802+ modules, perform the 
following:
• Check the equipment for any visible damage that may have occurred during 

transit.
• Confirm receipt of all items on the packing list. See “Checking the Packing 

List” on page 9 for more information.
• Remove the anti-static shipping pouch, if present, and all other packaging 

material.
• Retain the original packaging materials for possible re-use.
• Contact your Customer Service representative if parts are missing or 

damaged. See “Unpacking/Shipping Information” on page ix for 
information about returning a product for servicing.

Table 2-1. Maximum Power Ratings for 6800+ Frames

6800+ Frame Type
Max. Frame 
Power 
Dissipation

No. Usable 
Slots

Max. Power 
Dissipation 
Per Slot

FR6802+XF
(frame with AC power 
supply)

120 W 20 6 W

FR6802+XF48
(frame with DC power 
supply)

105 W 20 5.25 W

FR6802+QXF
(frame with AC or DC 
power supply)

120 W 20 6 W
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Checking the Packing List
Table 2-2. DA-H/HR6802+ Distribution Amplifiers Packing List 

Ordered Product Content Description

DA-H6802+ Distribution Amplifier Module

DA-H6802+ • One DA-H6802+ front module
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation 

and Operation Manual

DA-H6802+S • One DA-H6802+ front module
• One single-slot back connector 
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-H6802+D • One DA-H6802+ front module
• One double-slot back connector 
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-H6802+SR • One single-slot back connector

DA-H6802+DR • One double-slot back connector 

DA-HR6802+ Distribution Amplifier Module with Reclocking

DA-HR6802+ • One DA-HR6802+ front module
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-HR6802+S • One DA-HR6802+ front module
• One single-slot back connector 
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-HR6802+D • One DA-HR6802+ front module
• One double-slot back connector 
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-HR6802+SR • One single-slot back connector

DA-HR6802+DR • One double-slot back connector 

Table 2-3. DA-S/SR6802+ Distribution Amplifiers Packing List 

Ordered Product Content Description

DA-S6802+ Distribution Amplifier Module

DA-S6802+ • One DA-S6802+ front module
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-S6802+S • One DA-S6802+ front module
• One single-slot back connector 
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual
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DA-S6802+D • One DA-S6802+ front module
• One double-slot back connector 
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-S6802+SR • One single-slot back connector

DA-S6802+DR • One standard double-slot back connector 

DA-SR6802+ Distribution Amplifier Module with Reclocking

DA-SR6802+ • One DA-SR6802+ front module
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-SR6802+S • One DA-SR6802+ front module
• One single-slot back connector 
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-SR6802+D • One DA-SR6802+ front module
• One double-slot back connector 
• One DA-H6802+, DA-HR6802+, DA-S6802+, and DA-SR6802+ Installation and 

Operation Manual

DA-SR6802+SR • One single-slot back connector

DA-SR6802+DR • One double-slot back connector 

Table 2-3. DA-S/SR6802+ Distribution Amplifiers Packing List (Continued)

Ordered Product Content Description
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Setting Jumpers
You need to configure modules for local or remote operation before power-up. 
To change the configuration, first remove power from the module, reset the 
jumper, and then reapply power.

Setting J1 Jumpers
The J1 jumper is used to select local control reclock settings. Follow this 
procedure to set the jumpers:
1. Locate the J1 jumper set on the module. Figure 2-1 shows the standard 

location of the jumper set.
2. Place a shunt on the pin that corresponds to the mode that you want. (See 

page 14 for a description of the J1 settings.)

Figure 2-1. J1 Jumper Set Locations

J1
jumper
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Installing 6800+ Modules

Required Frames and Back Module Connector Types
DA-H/HR6802+ and DA-S/SR6802+ distribution amplifiers use single- or 
double-width back modules that can be installed in an FR6802+ series frame. 
See the FR6802+ Frame Installation and Operation Manual for details on 
installing back connectors in an FR6802+ frame.
These modules cannot be installed in 6800 / 7000 series frames.

Installing Modules
These modules require no specialized installation procedures. See the FR6802+ 
Frame Installation and Operation Manual for information about installing and 
operating an FR6802+ frame and its components. 

Removing Modules
These modules require no specialized removal procedures. See the FR6802+ 
Frame Installation and Operation Manual for information about removing 
components in an FR6802+ frame. 

Making Connections
Once you have installed the module, you can connect it to the appropriate input 
and outputs.
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Chapter 3

Operation

Overview
This chapter describes how to operate DA-H6802+, DA-HR6802+, 
DA-S6802+, and DA-SR6802+ modules using local controls only. See the 
following documents for information on how to operate this product remotely:
• + Pilot Lite™ User Manual for serial control interface
• CCS™ Navigator™, Pilot™, CoPilot™, or RCP-CCS-1U Remote Control 

Panel Installation and Operation Manual for Ethernet control interface
The following topics are discussed in this chapter:
• “Changing Parameter Settings Using CCS Software” on page 18
• “LEDs and Alarms” on page 20
• “Operating Notes” on page 14
• “Setting Remotely Controlled Parameters” on page 17
• “Understanding Parameter Types” on page 15
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Operating Notes
When you change a control parameter on a DA-HR/H6802+ or DA-SR/S6802+ 
module, the effect is immediate. However, the module requires up to 20 seconds 
to save the latest change. After 20 seconds, the new settings are saved and will 
be restored if the module loses power and must be restarted.

Understanding Jumper Controls

Introducing Jumper Control Types

Figure 3-1. Location of the Jumper Set

J1 Jumpers
You can use the J1 jumper to select local control reclock setting. Figure 3-1 on 
page 14 illustrates the location of this jumper. 
For local control, the J1 jumpers are used to determine reclocking mode. See 
“Setting Locally Controlled Parameters” on page 16.

J1
jumper
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Understanding Parameter Types
Most module parameters are adjustable, and can be set via a CCS software 
application (see “Setting Remotely Controlled Parameters” on page 17 and 
“Changing Parameter Settings Using CCS Software” on page 18). However, 
there are some parameters that are considered “read-only” and cannot be 
changed. Indicated by the abbreviation “[RO],” these parameters provide status 
and feedback information only.
Harris recommends that you use the available 6800+ software control options 
(serial/local or Ethernet/remote) to aid in viewing, setting, and confirming 
parameter values.

Adjustable Parameters
Two types of adjustable parameters can be changed:
• Numerical parameters require you to select a value within a numerical 

range.
• Selectable parameters require you to select a specific option.
Both numerical and selectable parameter changes are immediate.
Use the available 6800+ software controls (serial / local or Ethernet / remote 
network) to view and monitor parameter selections.

Read-Only Parameters
These parameters provide status and feedback information only. They are 
represented by LEDs on the front of the module’s card edge. See Figure 3-2 on 
page 20 and Figure 3-3 on page 21 for the location of these LEDs.
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Setting Locally Controlled Parameters

Local Control Reclocking Mode
In the local control reclock setting operation mode, all of the settings’ data 
status information appears on the + Pilot Lite control screen; however, you 
cannot change any setting in this mode via + Pilot Lite. (To control the 
reclocking setting mode via + Pilot Lite, set the J1 jumper to the remote control 
reclock setting operation mode.) 
For local control, the J1 jumper is used to determine reclocking mode. Table 3-1 
describes parameters that are accessible locally. 

Table 3-1. DA-HR6802+ and DA-SR6802+ Local Control Reclock 
Modes

Reclock Mode Description
AUTO (Default) Automatically detects the rate; if no selection rate 

jumpers are selected, the selection will be AUTO

270 Forces channel to lock to a 270 Mb/s signal
Set the jumper on the pin that allows the reclocker to 
handle 270 Mb/s data only
• If 270 reclock mode is selected, the 270 Mb/ s LED 

will turn on
• If the module can successfully lock to the input, the 

lock LED will turn on
• If reclocking is not successful, the lock LED will turn 

off and un-reclocked data will be present at output

1.5HD Set the jumper on the pin that allows the reclocker to 
handle HD (1.485 Gb/s) data only
• If 1.5HD reclock mode is selected, the 1.5G LED will 

turn on
• If the module can successfully lock to the input, the 

lock LED will turn on
• If reclocking is not successful, the lock LED will turn 

off and un-reclocked data will be present at output

3.0HD Set the jumper on the pin that allows the reclocker to 
handle HD (2.97 Gb/s) data only
• If 3.0HD reclock mode is selected, the 3.0G LED will 

turn on
• If the module can successfully lock to the input, the 

lock LED will turn on
• If reclocking is not successful, the lock LED will turn 

off and un-reclocked data will be present at output

BYPASS Forces channel to bypass the reclocker

REMOTE Selects reomote control operation
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Setting Remotely Controlled Parameters
Table 3-2 describes parameters that are accessible remotely. See your CCS 
control software application manual or online help for more information on 
setting and monitoring these parameters remotely. 
Legend
Bold option=Indicates that this is the default setting for the parameter.
[RO]=Indicates that parameters are read-only/feedback, and cannot be used to 
select controls.
All parameters clip unless otherwise noted.
 t

Table 3-2. DA-S6802+/DA-SR6802+ Remotely Controlled Parameters  

Name Range Description
Signal Present [RO] • 0=No

• 1=Yes
Indicates if input is present or not

Loss of Input Alarm • 0=Disable
• 1=Enable

Enables/disables Loss of Input alarm

Loss of Lock Alarm* • 0=Disable
• 1=Enable

Enables/disables Loss of Lock alarm

* DA-SR6802+ only
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Changing Parameter Settings Using CCS Software
You can change module parameter settings remotely by selecting the Loss of 
Input Alarm or Loss of Lock Alarm parameter setting.

Changing Parameters Using CCS Software
Before using CCS software applications to change your module’s parameter 
settings, you must refresh (+ Pilot Lite) or discover (Pilot and Navigator) the 
module. Refresh and Discovery are the processes by which your CCS software 
finds, and then connects to your module.

Refreshing Your Module Using + Pilot Lite
When using + Pilot Lite to change your module's control parameters, you must 
“refresh” the control connection between your 6800+ frame and PC. To refresh 
the connection, from the + Pilot Lite menu bar, select File > Refresh. For 
information about controlling a device using + Pilot Lite, see your + Pilot Lite 
User Manual.

Discovering Your Module Using CCS Software
To discover your DA-HR/H6802+ and DA-SR/S6802+ modules, your Pilot or 
Navigator software must be in Build mode. Follow these steps:
1. If the Discovery window is not open, click Tools > Discovery in the main 

menu.
A Discovery window opens, most likely in the bottom left corner of the 
screen.

2. Click Options, and then click Add.
3. Enter the IP address of the frame that contains your module, the frame that 

contains your ICE6800+ module, or the frame that contains a 6800+ETH 
module that provides access to your module.

4. Click OK to close the Add IP address window, and then OK again to close 
the Discovery Options window.

5. Click Start.
This triggers Pilot or Navigator to run a discovery.

6. When your discovery is complete, Discovery Completed is displayed in 
the Discovery window. To continue, click Save. The objects you you have 
discovered are saved to the Discovery folder of the Navigation pane.

You can now switch to Control mode by selecting Operational Mode > 
Control from the main menu. Double-click DA-HR/H6802+ or 
DA-SR/S6802+, as appropriate, in the Navigation pane. The Control window 
opens, displaying the module’s controls.
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Recalling Default Parameter Settings
You cannot recall default parameter settings for DA-H6802+, DA-HR6802+, 
DA-S6802+, and DA-SR6802+ modules.

Reading Software and Hardware Versions
The current software version of your DA-HR/H6802+ or DA-SR/S6802+ 
module can only be viewed using a CCS-enabled control panel or a CCS 
software application. See your RCP-CCS-1U Installation and Operation 
Manual, CCS software application user manual, or CCS software application 
online help for information on viewing software and hardware version numbers. 
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LEDs and Alarms

Module Status Indicator LED

Figure 3-2. Module Status Indicator LED

A module status LED reports the state of the module. See Figure 3-2 for the 
location of this LED, and Table 3-3 for a definition of the LED colors.

Table 3-3. Module Status Indicator LED Descriptions  

LED Color Sequence Meaning
Off There is no power to the module; the module is 

not operational.

Green There is power to the module; the module is 
operating properly.

Amber There is an alarm condition.
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Module-Specific LEDs

Figure 3-3. Module-Specific LEDs

Each 6800+ module has a number of LEDs assigned to indicate varying 
states / functions. See Figure 3-3 for the location of these LEDs, and Table 3-4 
for these functions.

Table 3-4. Module-Specific Status LEDs  

Name Color Function
PRES Green Input signal present

Off Input signal absent

LOCK* Green Signal locked

Off Signal cannot be locked

270 Green Input signal is relocked at 270 Mb/s

1.5G Green Input signal is relocked at 1.485 Gb/s

3.0G Green Input signal is relocked at 2.97 Gb/s

* DA-HR6802+and DA-SR6802+ modules only
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Alarms
If an alarm is triggered within your DA-HR/H6802+ or DA-SR/S6802+ 
module, the Status LED will turn off.
Alarms are usually logged and monitored within the available 6800+ software 
control applications (for example, + Pilot Lite or Pilot). See the appropriate 
software control user manual or online help for more information.

Table 3-5. Alarm Definitions

Alarm Name Alarm Description Alarm Level
Loss of input Indicates input signal is 

lost or absent
Major 

Loss of lock Indicates signal is not 
locked

Major
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Chapter 4

Specifications

Overview
The following specification tables appear in this chapter:
• “Inputs” on page 24
• “Outputs” on page 25
• “Power Consumption” on page 26
• “Performance” on page 26
• “Start-Up Time” on page 26
• “Temperature” on page 26
Specifications and designs are subject to change without notice.
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Inputs
Table 4-1. Input Specifications

Item Specification
Number of inputs 1

Signal type 3.0 G, HD, SD, ASI

Connector BNC per IEC169-8

Impedance 75Ω

Return loss >15 dB 5 Mhz to 1.5 GHz
>10 dB 1.5 GHz to 3.0 GHz

Maximum signal level ≥ 0.88 V

Cable equalization
270 Mb/s

HD

3.0 G

0-1,148 ft (0-350 m) Belden 1694A 
or equivalent
0- ft 492 (0-150 m) Belden 1694A or 
equivalent
0-328 ft (0-100 m) Belden 1694A or 
equivalent
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Outputs
Table 4-2. Output Specifications

Item Specification
Number of outputs 8 with double-width back module

4 with single-width back module

Signal type SD, ASI

Connector BNC per IEC169-8

Impedance 75Ω

Return loss >15 dB 5 MHz to 1.5 GHz
>10 dB 1.5G Hz to 3.0 GHz

Signal amplitude 800 mV ± 10%

DC offset 0.0 V ± 0.5 V

Rise and fall time
SD/ASI
HD
3.0 G

400-700 ps
< 270 ps
< 135 ps

Overshoot < 10%

Reclocking 2.97 Gb/s, 1.485 Gb/s, 270 Mb/s
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Performance

Power Consumption
Power consumption for DA-H6802+, DA-HR6802+,  DA-S6802+, and 
DA-SR6802+ modules is < 2.5 W.

Temperature

Start-Up Time
Module start-up time is approximately 3 seconds.

Table 4-3. Performance Specifications

Item Specification
Jitter 0.2 UI

Propagation ~5.0 ns (for reference only)

Table 4-4. Temperature Specifications

Item Specification
Performance temperature 32° to 122°F (0° to 50°C)

Operating temperature 41° to 113°F (5° to 45°C)
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Appendix A

Troubleshooting 

Overview
Find the following troubleshooting information in this appendix:
• “Contacting Customer Service” on page 33
• “Control and Monitoring Using CCS Software” on page 29
• “General Troubleshooting Steps” on page 28
• “Hardware Communication and Control Issues” on page 33
• “Software Communication and Control Issues” on page 30
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General Troubleshooting Steps
Follow these steps in troubleshooting 6800+ product problems:
1. Review the “Software Communication and Control Issues” on page 30 

outlined in this chapter.
2. Search this product manual and other associated documentation for answers 

to your question.
Associated documentation for 6800+ series products can generally be found 
in the product-specific manual that accompanies every module, in the 
FR6802+ Frame Installation and Operation Manual, and in the 6800+ 
Safety Instructions and Standards Manual.
Product documentation (including manuals, online help, application notes, 
erratas, product release notes, and more) can be found on our website, along 
with technical support information, training information, product 
downloads, and the product knowledge base.

3. Contact your Customer Service representative if, after following these 
initial steps, you cannot resolve the issue.
To contact Customer Service, see “Contacting Customer Service” on 
page 33.
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Control and Monitoring Using CCS Software
Before using CCS software applications to control and monitor your module, 
you must refresh (+ Pilot Lite) or discover (Pilot and Navigator) the module. 
Refresh and Discovery are the processes by which your CCS software finds, and 
then connects to your module.

Refreshing Your Module Using + Pilot Lite
When using + Pilot Lite to change your module’s control parameters, you must 
“refresh” the control connection between your 6800+ frame and PC. To refresh 
the connection, from the + Pilot Lite menu bar, select File > Refresh. For 
information about controlling a device using + Pilot Lite, see your + Pilot Lite 
User Manual.

Discovering Your Module Using CCS Software
To discover your modules, your Pilot or Navigator software must be in Build 
mode. Follow these steps:
1. If the Discovery window is not open, click Tools > Discovery in the main 

menu.
A Discovery window opens, most likely in the bottom left corner of the 
screen.

2. Click Options, and then click Add.
3. Enter the IP address of the frame that contains your module, the frame that 

contains your ICE6800+ module, or the frame that contains a 6800+ETH 
module that provides access to your module.

4. Click OK to close the Add IP address window, and then OK again to close 
the Discovery Options window.

5. Click Start.
This triggers Pilot or Navigator to run a discovery.

6. When your discovery is complete, Discovery Completed is displayed in 
the Discovery window. To continue, click Save. The objects you you have 
discovered are saved to the Discovery folder of the Navigation pane.

You can now switch to Control mode by selecting Operational Mode > 
Control from the main menu. Double-click DA-DHR/DH6802+ or DA-DSR/
DS6802+, as appropriate, in the Navigation pane. The Control window opens 
displaying the module’s controls.
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Software Communication and Control Issues
• “+ Pilot Lite Fails to Communicate with Installed Modules” on page 30
• “+ Pilot Lite Does Not Find All Modules in Frame” on page 31
• “+ Pilot Lite or CCS Software Application Not Responding” on page 31
• “+ Pilot Lite Cannot Control a Module Showing in the Control Window” 

on page 32
• “+ Pilot Lite Status Bar Reports ‘Not Ready’ Status” on page 32
• “CCS Software Application or Remote Control Panel Does Not 

Communicate with Module” on page 32
• “Alarm Query Fails When a Device Reboots” on page 32

+ Pilot Lite Fails to Communicate with Installed Modules
Confirm that the following items are not the reason for the communication 
failure:
• Proper module slot has not been specified (+ Pilot Lite is not 

communicating with the appropriate slot). See your FR6802+ Frame 
Installation and Operation Manual for more information on slot 
identification.

• COM port is used elsewhere (+ Pilot Lite is not communicating with the 
correct COM port).

• Actual Slot ID and Frame ID do not match with the two DIP switch settings 
in back of frame (+ Pilot Lite is not communicating with the appropriate 
slot and frame). See your FR6802+ Frame Installation and Operation 
Manual for more information on Slot ID and Frame ID DIP switch settings.

• An ICE6800+ or 6800+ETH module is installed in the frame (+ Pilot Lite 
control is disabled if an ICE6800+ or 6800+ETH module is installed in the 
frame; ICE6800+ and 6800+ETH modules are used for CCS control).

• A legacy 6800 series product is in the frame. + Pilot Lite cannot 
communicate with legacy 6800 series products. They will not be discovered 
or controlled by + Pilot Lite, although they can be installed in the 
FR6802+XF frame and work using card-edge controls. The module must be 
from the 6800+ product family.

• Check that the back module does not have any bent pins, following this 
procedure:
a. Unplug the front module.
b. Unscrew and remove the back module.
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c. View the 20-pin spring connector at the bottom of the back module.

Figure A-1. Back Module to Front Module Connector

This connector should not have any bent or pressed pins. Even a slightly 
depressed or bent pin may cause genlock issues.

d. If there are bent pins, carefully reposition them to their correct 
positions.
If this is not possible, you can exchange the back module for a new one 
(order part number DA-S6802+DR or DA-SR6802+DR).

+ Pilot Lite Does Not Find All Modules in Frame
If a discovery is started too soon after frame power-up, + Pilot Lite will not find 
all the installed modules. Refresh + Pilot Lite (File > Refresh), and ensure that 
installed modules are fully powered-up first before discovery.
If a module is plugged into the frame after a discovery, + Pilot Lite does not 
automatically detect the module. Refresh + Pilot Lite (File > Refresh) to 
discover the newly installed module. 
If a legacy 6800 series product is in the frame, + Pilot Lite will not detect it. + 
Pilot Lite cannot communicate with legacy 6800 series products. They will not 
be discovered or controlled by + Pilot Lite although they can be installed in the 
FR6802+XF frame and work using card-edge controls. For + Pilot Lite to find a 
module, it must be from the 6800+ product family. 

+ Pilot Lite or CCS Software Application Not Responding
+ Pilot Lite and CCS applications cannot run on the same PC at the same time. 
Both applications can be installed, but only one can be opened at a time.

20-pin
connector
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+ Pilot Lite Cannot Control a Module Showing  
in the Control Window

Consider these questions:
• Did you physically configure the module for local control? If so, configure 

the device for remote control.
• Does the card name in the control window physically match the card type in 

the frame? 
• Is the module properly seated in the frame? Check the positioning of the 

module in its slot in the frame.
• Does the Control window indicate the device is “ready”? The device may 

be powered off or disconnected from the network.

+ Pilot Lite Status Bar Reports ‘Not Ready’ Status
+ Pilot Lite reports each device’s connection status in the status bar. If the 
connection status message reads “Not Ready,” check the following:
• Is the module properly seated in the frame? Check the position of the 

module in the frame.
• Is the frame connected to the network? Check the device’s network 

connection.
If the status bar still reports no status or “Not Ready” for the frame or device, try 
restarting + Pilot Lite. 

CCS Software Application or Remote Control Panel  
Does Not Communicate with Module

CCS software applications (such as Pilot, CoPilot, and Navigator) and remote 
control panels require the purchase and installation of an ICE6800+ module in 
an FR6802+ frame (or and ICE6800+ or 6800+ETH module in a 
FR6802+QXF frame) in order to communicate remotely via Ethernet.

Alarm Query Fails When a Device Reboots
When you reboot a device connected to your PC, the alarm traffic hitting the 
network may cause an alarm query request to time out and fail. While the query 
does not automatically retry, it will post an “Alarm query failed” message to the 
Diagnostics window.
To clear an “Alarm query failed” message, right-click inside the Diagnostics 
window, and then select Refresh from the resulting context menu.
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Hardware Communication and Control Issues
• “Frame Fails to Communicate with the PC After a Power Failure” on page 

33
• “Module Does Not Seem to Work” on page 33

Frame Fails to Communicate with the PC After a Power Failure
You must exit the software application and restart after the frame recovers from 
its power failure. To restore communications between the PC and the frames, 
ensure that the frames have three or more minutes to recover from the power 
failure before you exit the application and restart the PC.

Module Does Not Seem to Work
Although the following troubleshooting tips may seem obvious, please take the 
time to ensure the following:
• All appropriate rear connections are securely made
• The board is securely installed (with no bent pins)
• The frame is turned on

Contacting Customer Service
We are committed to providing round-the-clock, 24-hour service to our custom-
ers around the world. Visit our website to find the Customer Service team in 
your geographical region.
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